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Welcome to issue 21 of Railway 
Photography, it is now a year since we 

started the product and during that time we 
have increased the distribution from just a 
handful of photographers to over 9,000 on a 
regular basis, either through direct e-mail or 
download from the website. I thank all those 
who have supported this venture, but sadly 
only around 10 per cent of those receiving 
the product send in material.
    I do urge more people to contribute and 
share their images.
    With the summer here (at least in the UK, 

which accounts for just 49 per cent of our 
readership) some reasonable weather has 
been seen to capture quality railway views.
    It looks if more change will soon be with 
us in the UK, with more new locos ordered 
and new operators such as Grand Central 
about to hit the stage with refurbished HST 
stock, keep a look out firstly in the Plymouth 
area and then on the Sunderland-London 
route as they are sure to be very different.

  Colin J. Marsden
Editor  
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The publishers of Railway Photography - 
TheRailwayCentre.Com Ltd - welcome 
submissions for inclusion. 
   We are looking for high resolution, 
good clear, but above all sharp images 
of any railway subject. Submissions 
should be sent by email in the .jpg 
format to rp@therailwaycentre.com 
please make sure that attachments are 
no larger than 6mb. We are happy to 
receive high-quality scans of negatives 
and slides. With all submissions please 
make sure you include your name and 
full details about the picture, including 
camera and exposure details.    
    As Railway Photography is distributed 
free of charge, we are unable to offer 
reproduction fees.
    We are happy to consider small 
editorial features on aspects of railway 
photography.

Editor: Colin J. Marsden
Design: TRC Publishing
Railway Photography is published by 
TheRailwayCentre.Com Ltd
PO Box 45
Dawlish, Devon
EX7 9XY
Tel: 01626 862320
E.Mail: rp@therailwaycentre.com
©therailwaycentre.com Ltd 2007

Below: The Network Rail New Measurement Train, led by recently named No. 43062 John Armitt, passes through 
Teignmouth on 10 August 2007 forming a Plymouth to London track testing special. The HST set, complete with one 
pantograph test car is now a frequent sight on the main lines of the UK rail network. Colin J. Marsden
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Adding a noticeable Bi-Line

Regular Railway Photography reader Wayne Parsons has asked about 
adding labels or caption blocks to his images that he wants to post 

on websites. Wayne said in his e-mail “After reading your comments 
about the use of a Fotopic website to share my pictures and after 
looking at one UK and one overseas discussion forum I am somewhat 
confused. You all indicate that by adding a ‘skin’ layer in Fotopic can 
reduce the quality of images, but I frequently see added blocks of text, 
sometimes in a colour banner to website pictures. Is it that this requires 
software or how can I apply such copy. I frequently look at one or 
two of the US picture-based websites and all these have a block at the 
bottom on the image with information. Are you able to provide any 
help?
    After receiving this e-mail and having a conversation recently with 
another photographer I thought it was time to show how easy it is to 
add information to an image.
    It is of course possible through any version of Photoshop, or other 
image handling software to add text to an image. This is achieved by 
selecting the text tool, clicking on the image and typing. Once you have 
the copy on screen you can edit it for style and colour and then use 
the <Move Tool> to position the text where you want it. When you are 
happy with the position you can <flatten> the layer and the text forms 
part of the image.
    However, the more professional way is to make up an overlay in 
Photoshop and drop this onto your image, position it and flatten the 
two leyers into one.
    The best way is first decide what size your image is going to be for 
display purposes, if we assume a size of 1024 pixel wide, the usual size 
for image display using Fotopic. You need to create a new Photoshop 
file at say 1024 pixel wide by around 20 pixel high. To do this go to 

File>New, you are then faced with a dialogue box, where you can enter 
a name - call it something like Name Overlay. Then in the width box 
change the dimensions to pixels and enter a value of 1024, in the height 
box, again change to pixel and enter a value of 20. In the resolution 
use 300 and in the colour mode RGB (if you are going to apply name 
or detail blocks to pictures which are going to be printed in books then 
you should choose CMYK). The next box says Background Contents, it 
is here you can decide the background colour for your banner. For our 
demonstration select background colour, the colour which you have 
selected in your Photoshop colour picker as ‘background’ will then be 
selected, so you might need to change this to say black. Once you have 
done this press OK and your box will appear.
    You are now able to write or insert a graphic into your box as with 
any other Photoshop item. Your text can be written and then edited and 
moved around, while you could import a graphic such as a logo into 
the box which you could again move around. Once you are happy with 
your wording and style flatten the image and save it as a file.
    When you want to use your newly formed panel, open your picture 
image file, reduce it to the size required, say 1024 pixel wide, then open 
the overlay file, place your curser in the box and <Select All> then 
<Copy>, then move to your picture file, click the picture once and paste 
in your overlay. Once its on the screen you can move it around with the  
‘Move Tool’, once you are happy with the position, flatten the image 
and the two ‘pictures’ are now joined together.
    If required you could create an overlay without a background, 
therefore your text would just sit on top of the image and use the picture 
as the background. This is sometimes quite nice if you place your 
captions in the sky of a picture. If you want a background less overlay, 
do not flatten the overlay file, which must be saved in a PSD format. 

Above: The overlay, made up in Photoshop, using a black background (chosen from the usual colour picker). Onto this two ‘blocks’ of text were applied, one with 
the caption details positioned and flattened towards the middle, and the other with the Copyright details positioned on the right and then flattened. Finally the logo of 
TheRailwayCentre was applied. This was pre formed at just slightly less height that the black banner to give a slight edge, saved as a .jpg and then imported in the normal 
way. Once this was in the position desired, the image was again flattened to make one image file containing all three elements.

Below: The new title or caption block is overlaid in Photoshop onto the original picture and moved to the desired position on the page. The picture file is then flattened to 
make one image of the two elements. For those interested the picture shows First/GBRF Class 66 No. 66727 hauling power cars Nos. 43163 and 43025 from Bristol SPM to 
Laira on 7 August 2007, passing Dawlish. Colin J. Marsden 
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The summer of 2007 will be the last to see large numbers of Class 150/2 sets painted in Wessex Trains ‘advertising’ livery, for route-operators First Great Western have 
said that the FGW-Local Lines livery, based on the ‘neon’  style applied to two sets earlier in the year will be adopted this autumn. Looking very clean, Class 150/2 No. 
150240 leading black-liveried Class 153 No. 153382 past South Brent on 14 July 2003 forming the 13.01 Exeter to Plymouth service. Colin J. Marsden 
Photographic details: Camera: Nikon D1X, Lens: Nikkor 35-70mm zoom @ 35mm, ISO: 250, Exposure: 1/800sec at f5.6



More on Colour Casts
Without doubt the most common question I receive about digital 

photography is that of colour casts, or images which turn out with 
a slight colour hew which was not seen by the photographer at the time 
of taking. In the past 20 issues of Railway Photography we have looked 
at several ways of making the finished results colour as it was seen by 
the photographer. Some of these operations can be a little clumsy for the 
less experienced Photoshop user and recently I have been experimenting 
with other ways of improving the overall colour.
    Some of the experts in the use of Photoshop in the US adopt a method 
using a layer - do not be put off by this it is quite simple and worth 
trying. It will take a little getting used to and a bit of trial and error, when 
for around 90 per cent of images it works well, providing your image has 
an overall colour cast.
    Firstly open the image in Photoshop CS in the normal way, then go to 
Layer>New Adjustment Layer and select Levels, you will be faced with 
a  <New Layer Box>, you can name your layer if you wish, but I usually 
leave this black, make sure colour is set to ‘none’ the mode is ‘normal’ 
and the opacity set to ‘100%’, click OK and you will have a <Levels Box> 
appear on the screen, this looks a little daunting, but everything is quite 
simple. At the top you have a  <Channel> selector, leave this as RGB 
meaning you are working on all three channels (red, green and blue), at 
this stage do not adjust the sliders, but go to the bottom right side of the 
window and you will find three ‘eye droppers’, these represent from left 
to right ‘black’ ‘grey’ and ‘white’, select the middle or ‘grey’ dropper.
    With this selected your screen cursor turns into a colour dropper and 
walk it around your image, looking for a pure mid-tone white/grey, you 
might find this in the roof of the train, a line side structure, a carriage or 
even in the sky.
    Have a go and select various spots in the image and you will notice 
how the entire colour changes, it might go dark blue, bright yellow 
or even red, but if you select a pure mid-tone grey, your image will 
suddenly lose all its colour cast and the colours will change to the correct 
tones. 
    This all sounds very hit and miss - well it is, but most pictures have 
something in them on a pure mid-tone grey and when found this will 
balance out all the other ‘higher’ and ‘lower’ colour levels.
    Once you have found the desired level, before you ‘OK’ the selection 
you can fine tune any of the specific colours by selecting either the 
red, green or blue channel from the top channel box and make very 
small changes, usually using the middle of the sliders. If after using the 
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dropper the entire image is too dark, by having the RGB selection in the 
top box use the sliders to adjust the overall darkness or brightness of the 
image.
    Once you have made your adjustments press the OK button. Your 
changes are now saved in a ‘layer’ rather than on the original image. If 
any specific section of the image did not require the colour cast change, 
this can be reverted to the unchanged colour by using the ‘Brush’ tool 
(fourth down from the main tool menu) and by selecting a suitable size 
brush you can ‘paint-over’ any section which will revert to the pre-
edited colour tone. Once you have achieved the desired colour editing, 
go to Layer>Flatten Image and all your changes will not be saved on 
the master picture. Once this has been done you can then carry out 
other editing work, such as cleaning up the picture, straightening and 
trimming.

Above: The above image of Class 47 No. 47847 at Langstone Rock is ‘off-
camera’ taken on 200ISO at 1/1000 at f5.6. The image is a little biased to yellow 
and would not look right in reproduction. An image such as this has several 
‘grey points’ from which to get the right colour cast. 

Below: The adjusted image using the Level Adjustment Layer and using the grey dropper technique. The image regains the proper colour balance, especially in the 
green trees and grass, while the blue bodywork on the ‘47’ and turquoise livery on the One-Anglia set looks accurate.

CJM
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Above: The Network Rail/DRS-operated track and infrastructure test trains usually generate an amount of interest to photographers, with the colourful trains, 
frequently visiting unusual lines making a change from the usual run of the mill pictures. Early on the morning of 24 July 2007 train No. 1Q14 ‘top and 
tailed’ by DRS Nos. 37218 and 37259 is seen at Maiden Newton having just taken the single line token for the section to Yeovil Pen Mill, while running on a 
Weymouth to Westbury leg of a full days recording which finished at Eastleigh. Often photographers would avoid including lineside furniture such as these stop 
boards, but in this case it adds interest to the image and records the trains location. Tom Mcatee
Photographic details: Camera: Canon EOS30D, Lens: Canon zoom at 40mm, ISO: 125, Exposure: 1/500 @ f5.6   

Below: DRS Class 37/6 No. 37605 powers Network Rail test train 1Q18 from Derby RTC to Norwich past Santon on the afternoon of 6 August 2007. Overhead 
Line test coach Mentor (Mobile Electronic Network Testing & Observation Recorder) is marshalled in the middle of the train, while sister loco No. 37606 is 
coupled on the rear. Oli Smith 
Photographic details: Camera: Nikon D80, Lens: Nikkor 18-135mm zoom at 50mm, ISO: 320, Exposure: 1/1000 @ f5

Railway PictorialRailway Pictorial
Railway Photography looks forward to receiving your 

pictures for inclusion in these pages, please send 
high-resolution images to RP@therailwaycentre.com and 

share your work with others.
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Above: We think this image should be used as a Photoshop training picture on cloning out unwanted seagulls. The photographer found this interesting view 
of yet another Network Rail track inspection train ‘top and tailed’ by No. 37259 and 37218  at Manningtree on 1 August 2007 working between Norwich and 
Ilford, only to find as the train approached several hundreds of gulls took off. Thankfully none have blocked the train and some people might think it enhances the 
overall image to show the river scape. Whatever - it would be excellent for Photoshop training! Michael J. Collins
Photographic details: Camera: Canon EOS20D, Lens: Canon zoom at 67mm, ISO: 200, Exposure: 1/640 @ f8 
 
Below: To prove our friends at Direct Rail Services operate other trains apart from Network Rail track test formations. On 6 August 2007 we see more Durham 
coast activity as Nos.  37087 and 37194 power train 6M60 from Seaton to Sellafield, formed of one FNA flask wagon. The train is seen passing Hawthorn.
Ken Short 
Photographic details: Camera: Nikon D200, Lens: Nikon zoom at 34mm, ISO: 400, Exposure: 1/1250 @ f5.6 
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Above: This is certainly a different view of the picturesque Thames Valley line between Reading and Didcot, and shows a Virgin Voyager on the down line near Cholsey.  
The selection of location and the gap between the trees either side of the bridge is as near perfect for a four car Voyager as you could ever expect to obtain (if the train had 
been one of the five-car versions the photographer might have uttered a few swear words. Considering the train at this point would have been travelling at around 90mph, 
the reaction speed of the photographer had to be excellent to press the shutter button at just the correct time. Ken Brunt 
Photographic details: Camera: Canon EOS10D, Lens: Canon 70-200 zoom at 146mm, ISO: 200, Exposure: 1/750sec @ f6.7

Below: With what looks to be the mother of all storms brewing, our photographer said “As Luxembourg has not been covered yet in the pages of RP, I am submitting 
this one. After taking some pictures of a steam train extra during the “Clouds over Ettelbruck” festival, I could just make it back to the waiting shelter of the nearby 
Schieren-station. After the thunderstorm passed, I took this shot of the international service from Liers (Belgium) to Luxembourg via Gouvy”. The photographer 
records it was 11.28 in the morning but it could well have been night! The two waiting shelters in white make a good contrast against the black sky. An excellent 
picture considering the lighting conditions and well positioned with the wetness! Raymond v/d Hoven
Photographic details: Camera: Canon EOS300D,  Lens: Canon zoom, ISO: 200, Exposure: 1/250sec @ f4.5
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Above: With the November franchise changes, the Class 220 ‘Voyagers’ will soon be extinct on the West Coast Main Line. Set No. 220004 passes Dillicar forming the 
15.56 Manchester Piccadilly to Edinburgh Waverley on 24 July 2007. The framing of the train with the mauve foliage in the foreground and framing the train superbly 
between the overhead power stanchions makes this a picture to be proud. Mark Bearton
Photographic details: Camera: Canon EOS 20D, Lens: Canon 70-200mm zoom at 73mm, ISO: 200, Exposure: 1/640sec @ f7.1

Below:  Our photographer here told RP that he has been visiting the Ipswich to Felixstowe Branch for many years to record freight and passenger services on the line, 
however it is only just recently that he found this location at Grimston Lane crossing, where a former Great Eastern Railway crossing-keepers cottage (now enlarged) 
can be included in a picture, providing an impressive and railway related frame to a picture. On 19 July 2007, Freightliner Intermodal No. 66567 passes over the 
crossing and by the cottage as it powers an Ipswich Yard to Felixstowe container working. Michael J. Collins 
Photographic details: Camera: Canon EOS 20D, Lens: Canon zoom at 38mm, ISO: 200, Exposure: 1/800sec @ f8
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Above:  CargoNet in Norway operate a fleet of six Class 66s, owned by HSBC Rail. Built to order No. 20018352 the locos operate freight on Trondheim to Bodø
line and are quite hard to track down for photography. Our photographer was told that the drivers are not that happy with their charges due to high cab noise 
(similar to the UK). CargoNet No. 66406 is seen in the yard at Bodø with a southbound liner train on 30 July 2007.  Phil Wormald
Photographic details: Camera: Canon EOS 5D,  Lens: Canon zoom at 80mm, ISO: 640, Exposure: 1/500sec @ f8

Below:  While the CargoNet locos are basically the same as the UK examples, air conditioning is fitted to the cabs, with a roof mounted module and protection frame. The 
horns are positioned on the roof in the centre of the loco and thus the above cab front window area is solid and different lamp clusters are fitted. The most noticeable change 
is the fitting of snowploughs on the front end. No. 66401 is seen at Mo i Rana with a southbound liner train on 30 July 2007. Phil Wormald
Photographic details: Camera: Canon EOS 5D,  Lens: Canon zoom at 40mm, ISO: 400, Exposure: 1/800sec @ f5.6

Another look at the Euro 66sAnother look at the Euro 66s
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European Rail Shuttle No. 6614 Lauryn, owned by Mitsui Rail Capital Europe passes 
Oberwesel on the left (west) bank of the River Rhine between Bingen and Koblenz with a 
northbound container train from Basle on Sunday 15 July 2007. Brian Stephenson
Photographic details: Camera: Nikon D200,  Lens: Nikkor 17-55mm at 44mm, 
ISO: 250, Exposure: 1/1000sec @ f4
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Another view of European Rail Shuttle No. 6614 Lauryn, taken on 12 July 2007 shows the loco pulling out of Loreley tunnel on the right (east) bank of the River 
Rhine south of St. Goarshausen with a container train bound for Basle. The front end style of these Euro 66s is very much in keeping with the UK style, except for 
slightly modified light clusters and European style air pipes and buffers. Compared to the previous illustration of this loco on page 11, this time the three door side is 
nearest the camera. Brian Stephenson
Photographic details: Camera: Nikon D200,  Lens: Nikkor 17-55mm at 26mm, ISO: 250, Exposure: 1/800sec @ f4
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Above: Owned by HSBC Rail and operated by Häfen und Güterverkehr Köln (HGK), No. DE 668 was introduced on 4 September 2003 and originally carried 
the number DE168. It is seen having just passed Bacharach on the left (west) bank of the River Rhine between Bingen and Koblenz with a northbound train of car 
empties on Friday 13 July 2007.  Brian Stephenson
Photographic details: Camera: Nikon D200,  Lens: Nikkor 17-55mm at 48mm, ISO: 320, Exposure: 1/640sec @ f6.3

Below:  Built in February 2006 as works number 20048653-09 and owned by Mitsui Rail Capital Europe as No. 653-09, this loco is on lease to Dillen & Le Jeune Cargo 
Railway (DLC) and is officially numbered  DE6305. On 15 June 2007 it is recorded passing Oberwesel on the left (west) bank of the River Rhine between Koblenz and 
Bingen with a southbound container train. Brian Stephenson
Photographic details: Camera: Nikon D200,  Lens: Nikkor 17-55mm at 26mm, ISO: 250, Exposure: 1/800sec @ f7.1



Railway Photography14

Above: Taken at Barghteheide station a double-deck formation ‘top and tailed’ by Class 218s Nos. 218 102 2 and 218 103 0 on the rear, pass at speed on train 
RE21415, the 11.05 Lübeck to Hamburg HBf express. Overhead masts are spreading south over this route rapidly and the end is now in sight for Class 218s on 
this line. Due to franchise changes, Class 218s are also shortly due to disappear from Harburg to Cuxhaven services as well.
Photographic details: Camera: Canon EOS30D,  Lens: Canon 24-70mm zoom at 43mm, ISO: 200, Exposure: 1/1600sec @ f5.6 
DB 218s in Schleswig-Holstein

 
DB 218s in Schleswig-Holstein

By Richard Stiles

Below: The island of Sylt is connected to mainland Germany by a long causeway known as the Hindenburgdamm. Since the causeway is rail only, and there 
are no other road connections, all vehicles must use ‘Autozug’ trains hauled by double-headed Class 215s or 218s to reach Sylt. Here Nos. 218 182 4 and 218 184 0  
power an afternoon Niebüll-Westerland ‘Autozug’ at Keitum on 7 June 2007. Drivers remain in their vehicles while travelling on this service and cars use double 
deck transporters while large vehicles are carried on flatbed wagons at the rear. With the presence of bicycles on some of the cars we must be thankful for the 
German loading gauge!
Photographic details: Camera: Canon EOS30D,  Lens: Canon 24-70mm zoom at 70mm, ISO: 200, Exposure: 1/1600sec @ f5.6
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By Richard Stiles

Above: The area around Lübeck has always been popular with photographers and was once a stronghold for the V200 German ‘Warship’ class. Soon the view 
from this vantage point will be virtually lost for when the overhead wires are erected the scene will not be the same! On 8 June 2007, Class 218 No. 218 431 5 
powers train RE21427, the 17.05 Lübeck to Hamburg seen departing the picturesque station. When this picture was taken, Hamburg trains were terminating at 
the HBf and connecting with a ‘218’ hauled shuttle to Lübeck Travemünde Strande.
Photographic details: Camera: Canon EOS30D,  Lens: Canon 24-70mm zoom at 24mm, ISO: 250, Exposure: 1/1000sec @ f7.1

Below: Niebüll station sees a surprisingly wide selection of traffic given its relative remoteness. Nord-Ost-See Bahn (NOB) operate loco-hauled services from 
Hamburg Altona to Westerland and they also run a single car DMU to TØnder in Denmark. Inter-City trains are operated by DB and worked by double-headed 
Class 218s. Through coaches for Dagebüll Mole are uncoupled at Niebüll and collected by NEG’s DMU shuttle. Further variety is provided by DB Autozugs and 
occasional freight. Coupled with the semaphores and a busy stabling point, there is plenty to see at Niebüll. Here Nos. 218 462 0 and 218 494 3 power train No.  
IC2181 the 11.56 Westerland to Gottingen on 7 June 2007. Note the pigeon in the foreground just escaping in time!
Photographic details: Camera: Canon EOS30D,  Lens: Canon 24-70mm zoom at 35mm, ISO: 200, Exposure: 1/2000sec @ f5
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From a different viewpoint........From a different viewpoint........

Left: The all important 
framing of the subject has 
been done well here and with 
very accurate depression of 
the shutter button. A Virgin 
Pendolino is framed by an 
advertising board for the 
nearby Plough public house, 
alongside the Coventry 
canal, at Huddlesford near 
Lichfield, Staffordshire. The 
photographer said “Hopefully 
there will be more vegetation 
cleared and more photographic 
opportunities in this area as 
this is part of the TV4 WCML 
Trent Valley four-track 
upgrade, the location (canal 
towpath/marina) is currently 
closed while a second bridge is 
put in place for the additional 
two tracks. Illustration taken 
on 11 May 2005. Phil Grain
Photographic details: 
Camera: Canon EOS 
1000S, Lens: Canon 35-
80mm zoom, Film: Provia 
F 100ASA, Exposure: 
1/60sec

Below: An excellent and very atmospheric silhouetted by sunset shows EWS Class 66/0, No. 66173 and Bardon Hill signal box in May 2005. No. 66173 was waiting 
to work out a Bardon Hill with an East Anglia bound stone train, when the lighting produced this effect. It is usually only the brave photographers to attempt such 
exposures, but when done it usually works very well. The presence of the red tail lights on the ‘66’ help to lift the image. Phil Grain
Photographic details: Camera: Canon EOS1000N, Lens: Canon 35-80mm zoom, Film: Provia 100f, Exposure: 1/60sec @ f11
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From a different viewpoint........From a different viewpoint........

Above: Well this is most certainly a ‘different view’ and very few would have even thought of taking. I guess that if one is trying to take movie and stills at the same time 
this is one answer. Joking aside, this is a very well seen ‘different’ view and has worked so well with the out of focus background throwing the eye directly onto the image 
on the video cameras screen, the inclusion of the camera, again out of focus, shows without doubt what the picture is about. The view was taken at Headstone Lane of a 
Silverlink Class 313/1 on 12 June 2007. Richard Stiles
Camera: Canon EOS30D, Lens: Canon zoom at 45mm, ISO: 320, Exposure: 1/125sec @ f4.5 
Right: A westbound Union 
Pacific manifest freight near 
Echo, Utah, USA catches the 
sun as smoke in the distance 
gives a most eerie effect.
Phil Cotterill
Photographic details:  
Camera: Pentax K1000 
Lens: Pentax, Film: Sensia 
100, Exposure: 1/250sec @ 
f11. Scanned on Epson 4870 
at 800dpi.

Back Cover:  This excellent 
‘train-less’ picture captured at 
West Ruislip looking directly 
into the sun was taken in 
a Canon RAW format and 
then edited in Photoshop, the 
photographer says he removed 
some ‘bright spots’ and 
darkened some areas. He added 
“Taking the image looking 
directly into the sun created an 
interesting effect on the tracks 
and sidings in the foreground”. 
Richard Stiles
Photographic details: 
Camera: Canon EOS30D, 
Lens: Canon 24-70mm 
zoom at 62mm, ISO: 100, 
Exposure: 1/8,000sec @ f7.1




